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Information Technology Overview 

 This document contains an overall picture of the Information Technology setup for 

Swagger Distribution. It shall serve as a reference guide for current IT infrastructure and 

includes several recommendations for improvements in the current structure and beyond. This 

may be used as both a quick-start document for new employees in all departments to become 

familiar with common software used at the company, and for best practices for ensuring an 

understanding and good practice of security protocols. 

 

Summary 

 A full understanding of the Information Technology implementation at Swagger 

Distribution is both key to efficiently using its systems, but also maintaining the security of 

company, employee, and client information. In order to ensure ease of use, full integration 

between workstations, software, databases, and servers has been achieved. This allows the IT 

department to effectively provide solutions to technology problems or concerns in the most 

efficient way. Client workstations are connected to the local network to provide inter-office 

communication throughout the office network (LAN). Internet access is then provided to each 

connected device through the LAN, and secured through the hardware firewall on the edge of the 

network. Database, email, and other servers are hosted in-house behind the firewall to provide 

ease-of-access and security to everyone on the network. This LAN is what enables each Swagger 

Distribution employee access to required software like Microsoft Word and Visio. Additionally, 

the customer and supplier database has been optimized to ensure accurate reporting in the future. 



While the database currently stores billing information for customers, as you will see in the later 

recommendation it is suggested to move this to a third-party processor. A detailed description of 

the networking setup that provides this connectivity may be found in a later section. 

 In order to remain competitive in today’s internet-based economy, several 

recommendations are available in the Web Technologies Consult section in order to modernize 

the Swagger Distribution website for ease of access. These changes are necessary to provide 

quick and easy communication with existing and new clients, and to make sure the website is 

easily accessible through any browser and device. 

 Finally, a security audit was performed and several recommendations are made to ensure 

the security of the Swagger Distribution network. The current IT solution allows for easy access 

to the Swagger Distribution LAN and all connected servers and devices, but this must remain 

secure to protect employees and clients. Making those changes will help to ensure that each part 

of Swagger Distribution’s IT solution provide the network access required for all employees 

while maintaining a high level of security on the network. 

 

Human-Computer Interface 

 Microsoft Word and Visio are two professional applications that make up part of the 

Microsoft Office suite of software developed specifically for users in a work environment. Word 

is a powerful computer word processing application that allows you to compose documents like 

memoranda and reports. Visio is an advanced application that allows for easy creation of 

flowcharts and diagrams, which can be helpful for presentations or written reports in Word. 

 You will primarily interact with both Word and Visio by using your keyboard and mouse, 

guided by descriptive tabs located in the “ribbon” navigation panel above your work. By using 



visual effects such as differing text colors, numbers for font size, examples of fonts, and small 

icons, the ribbon in both Word and Visio, you are intuitively guided to the tools and features that 

you wish to use. The ribbon is present and consistently formatted throughout the Office suite of 

applications, so mastering it in one will allow you to quickly jump into using any other Office 

application. 

 Word and Visio attempt to mimic actions you may take in the real world within the 

ribbon, providing quick access to frequently used actions. The “File” tab within the ribbon, for 

example, works as a virtual filing cabinet. From here you are able to save, open, close, print, and 

create new projects - similar to many actions you would take with a physical filing cabinet. The 

“Home” tab functions as your virtual desktop within Word and Visio, allowing easy 

manipulation of the visuals for your project. Common functions include: text transformation, 

where you may apply bold, italics, and underline styles as well as changing the font itself, 

highlighting, or changing text color. Though the “Home” tab is different in both Word and Visio, 

they do share common functions and have separate areas for Word or Visio-specific actions like 

section headings in Word and shape styles in Visio. By clicking on any of the text transformation 

functions, as an example, Word presents you with an immediate visual cue of what the change 

will look like on the button. By selecting your desired text and clicking the “Bold” button, the 

selected text will be immediately updated by displaying thicker lettering for the selection. In 

Visio, selecting an existing shape and clicking the “Fill” button will allow you to change the 

color within the selected shape. A good tip to keep in mind is that the “Home” tab is primarily 

focused on modifying existing content rather than inserting new content into your project. Tabs 

like “Insert” in both Word and Visio provide specific tools for creating new content within your 

Word document or Visio flowchart/diagram. The “Design” tab located within the ribbon in Word 



and Visio gives you quick access to making major visual design changes to your project. Both 

applications allow for sweeping color and style changes across your document or 

flowchart/diagram, like changing the color scheme or modifying fonts and text formatting. The 

similarities diverge from there, where the following ribbon tabs display functions directly-related 

to either Word or Visio editing. The tail end of the ribbon ties up loose ends with the “Review” 

and “View” tabs, enabling you to run spell check, translations, or control how the project looks 

on your computer. Think of those tabs as your editor and design assistant, respectively. 

 One enhancement that may benefit users of Word and Visio would be to better visually 

distinguish between the two applications. By utilizing the same color schemes and ribbon 

formatting, it may be easy to confuse the two applications when manipulating content in both 

during the same session. Like the differences in color between Word, Excel, and PowerPoint, 

Visio may deserve its own unique color scheme to prevent any confusion. 

  

Visio Quick Tutorial 

 If you have used Word previously, learning to use Visio will be a fairly simple task. The 

similarities described above will ensure that you are at least comfortable with navigating the 

ribbon, with its close ties to the familiar ribbon in Word. There are some unique functions and 

menu options that are unique to Visio, however, and mastering them will be vital to creating 

effective flowcharts and diagrams. Below is an overall view of Visio. Notice the similarities to 

Word, and get ready to dive in! 

File Menu: Present in Word and 
Visio, like your digital filing cabinet! 



 

Above: The Visio “Command Center”, which is what we like to call your combination of the 

tools you will use most. 

 

 The three most important basic-yet-powerful tools that you will use within Visio are the 

“File” tab, the ribbon, and the “Shapes” window. These three functions comprise the “Command 

Center” that will likely take up most of your clicking, design, and editing within Visio. As 

mentioned previously, the “File” tab acts as your virtual filing cabinet and allows you to create 

new projects, save them, close them, or share/print them for others. The ribbon gives you quick 

access to common functions, like changing fonts, making connections between shapes, and 

changing the styles of the objects in your Visio project. These two functions are very similar to 

what you are familiar with doing inside of Word. Unique to Visio, however, is the Shapes 

window. This tool will allow you to draw pre-defined shapes for your flowchart or diagram and 

contain helpful descriptions next to each one. Knowing which shape is generally used for a step 

Shapes: Where you will utilize pre-
defined shapes to create your 
flowchart or diagram. 

The Ribbon: You already know 
and love this, and it is back to help 
with quick actions in Visio! 



(or “process” in Visio), or which is used when a choice must be made (a “decision”), the Shapes 

window will guide you to creating effective and understandable flowcharts and diagrams. 

 Inserting shapes is easy and fun. You can start by clicking on the “Process” shape located 

on the left, within the Shapes window, as seen below: 

 

Then just click and hold down your mouse button on “Process” and drag the shape to your page 

on the right. This will insert the rectangular shape seen to the right. If you want to label the 

process, simply double-click within process shape you dragged to enter its edit mode, where you 

may give the shape a label. A “decision” can be inserted in the same way, by clicking and 

dragging on the “Decision” shape within the Shapes window, then dragging it to your page on 

the right. If you wish to connect the two, you may do so by clicking on the “Connector” function 

under the “Home” tab in Visio’s ribbon as seen below: 

 

Once you have clicked on “Connector”, your shapes will be highlighted, with “hot spots” 

appearing around the shapes where connections may be started and terminated, as seen below: 

Click and drag here to insert a 
process shape. 

Connector: A function used for 
connecting flowchart shapes and 
guiding the viewer through the 
chart. 



 

By clicking and dragging on the middle-right connector dot of the rectangle over to the left point 

of the diamond, a connection between the two shapes will be made: 

 

 In the case described above, a human-readable version of the flowchart would say that 

you begin with the “Process” rectangle and then proceed to make a decision at the “Decision” 

diamond. In a complete flowchart, the decision diamond would be connected to another step in 

the “Process” or lead you to another “Decision” that must be made. These basic functions are all 

that are necessary to create a basic flowchart or diagram. More detailed versions may be made as 

you become more familiar with Visio’s functionality. 

 

Databases 

 The database utilized by Swagger Distribution is a simple database used for easily 

tracking the distribution of products from clothing manufacturers to the retail stores that sell the 

product. The information stored within the database allows Swagger Distribution employees to 

track which products are sent to which retail stores, and what manufacturers supply those 

products. Details of each product are also tracked, including the name of the product, its color, 



the wholesale price to retail stores, and the manufacturer’s suggested retail price that the stores 

charge their customers. The data types used for each field enables the database to distinguish 

between descriptive text (“Short Text”), numbers (“Number”), or currency (“Currency”) within 

each field in each table. These data types serve as a sort of metadata, describing what type of 

information is contained within the “Field Name” for each field in a table. Descriptions may also 

be used, providing a more detailed account of what the data in each field is, or what it will be 

used for. Utilizing accurate data types for the type of data that will be present makes generating 

readable reports quick and easy. 

 Specifically, the “Clothing Manufacturers” table includes specific information on each 

clothing manufacturer that Swagger Distribution receives product from. This table stores the 

name of the manufacturer, their street address, city, state, and ZIP code. Next, the “Clothing 

Products” table stores detailed information on each product that Swagger Distribution sells to 

retail stores. This table includes a short description of the product, its color, the name of the 

manufacturer that makes it, the wholesale price that Swagger Distribution sells it for, and the 

retail price that retail stores charge their customers for each product. Finally, the “Retail Stores” 

table contains information on each retail store that Swagger Distribution provides wholesale 

products to. This table includes each store’s name, street address, city, state, ZIP code, and the 

clothing item that Swagger Distribution sells to them. Each table includes a “Primary Key”, or 

unique identifier, that enables a relationship between relevant data in each table to be shared 

within the database. 

 By changing the data type of the “Retail Price” field within the “Clothing Products” table 

from “Short Text” to “Currency”, the display output for values within the “Retail Price” field 

within that table are properly formatted to reflect an amount of dollars. Previously the retail price 
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was formatted as a simple number (like 25), but applying the “Currency” data type formats it 

correctly as an amount of money (like $25.00). 

 The “Retail Purchases” query is currently a broken query because of the way that each 

table is linked together within the query. In order to link each of the tables together, a “Primary 

Key” is used from each table. In order for the query to run successfully, the value in the field that 

is assigned as Primary Key in each table must be present. Since the “Retail Stores” table is 

missing values in the “Clothing Item” field, the primary key from the “Clothing Products” table 

is not successfully linked to the retail store that it is sold from. The query is attempting to 

generate a report on which retail store sells which product (or products), in which state, by which 

manufacturer, and for how much it is sold to consumers. By selecting a value for the “Clothing 

Item” for each retail store listed in the “Retail Stores” table, these keys are successfully linked 

and the query returns the expected results. 

 The results of the query quickly displays the products that have been purchased from 

Swagger Distribution, by which retail stores, the state the store is in, who makes it, and how 

much the retail store charges their customers for the product, as seen below: 

 

 

Programming 

 The changes requested by the new owner are displayed below: 

Michael Singletary


Michael Singletary


Michael Singletary


Michael Singletary




 

 The key components required to make the requested changes include inserting an 

additional “System.out.println” line, or program statement, within the applet. This tells the 

program to now print a second line’s statement to the welcome greeting displayed when 

employees login each morning, welcoming them to work. Additionally, text was modified with 

the original program statement to reflect the desired language change of the new owner, 



informing users of “Today’s date” instead of “Current date.” The values of “Today’s date” are 

determined from the integer variable definitions made at the beginning of the program, telling 

the compiler how day, month, year should be generated based on the type of variable and that it 

is obtained through the calendar. Once these variables have been defined and determined by the 

program, they may be included in the output generated by the program statement. 

 
Network Consult 

 The wired network for Swagger Distribution is a standard T1-based network consisting of 

expected devices like a main router, firewall, switch, servers, bridges to the office and 

warehouse, and user-level computers connecting to the network. Though the current network 

setup is good, there are a number of recommended improvements for greater networking speed 

and future-proofing. 

 Access to the internet (WAN) is currently provided via T1 connection from the Internet 

Service Provider (ISP), providing speeds of up to 1.54 Mbps. This is no longer sufficient for an 

internet-based business and should be upgraded to at least a T3 connection (if available from the 

provider) or a business-grade connection from a major cable company or Verizon FiOS (where 

available. A T3 connection will increase speeds up to 45 Mbps, while a cable company or FiOS 

can provided speeds in excess of 300 Mbps, potentially at a cost savings. A cable internet 

connection of DOCSIS 3 or better is recommended, but may be unavailable due to lack of cable 

service in area. Verizon FiOS may require fiber optic cables to be run outside and inside the 

building, but may be worth the investment for fast and reliable internet speeds. 

 The WAN connection meets the local Swagger Distribution network (LAN) at the Main 

Router, which then connects to the firewall and main switch to bring WAN and LAN access to 

the buildings. According to Cisco, the PIX Firewall is no longer sold or supported, and their 



recommended upgrade path is to the Cisco ASA 5500 Series Adaptive Security Appliance. The 

main Ethernet switch present should be upgraded to support gigabit speeds, if this is not already 

supported. 

 The Ethernet switch provides access to the Swagger Distribution LAN to each device on 

the network, which is then connected to the WAN for shared internet access across both 

buildings. The network connection to the offices is provided by the switch and run via Ethernet 

from a cross-panel patch to the drop cables and Ethernet terminals at each workstation. This 

cabling should be checked to ensure it is CAT6 cabling, to take advantage of the existing or new 

gigabit Ethernet switch. Office PCs are then connected directly to the network via Ethernet, 

providing reliable and fast connections to the office LAN and internet. Connectivity to the 

Warehouse is provided via fiber optic cabling, which is good but severely under-utilized by the 

slow T1 connection. Upgrading the internet connection as mentioned earlier will take greater 

advantage of the faster CAT6 Ethernet cabling and the faster and more reliable fiber optic 

cabling to the warehouse. A remote Ethernet switch in the Warehouse converts the fiber optic 

connection to Ethernet, which is then directly connected from the switch to each PC workstation 

in the shipping office. Depending on the distance between the main Ethernet switch and the 

Office PCs, an additional switch may be needed in between to ensure proper Ethernet cabling 

distance. CAT6 Ethernet cables are rated for a maximum of 100 meters, or 328 feet. If the 

distance between the main switch and workstations are greater than this, an addition switch 

should be added to increase the distance. The servers are connected directly to the main Ethernet 

switch to connect to the WAN and LAN and, due to their proximity to the switch, do not require 

additional networking equipment. 



 Wireless Access Points (WAP) may be used to provide Wi-Fi connectivity throughout the 

offices and warehouse, enabling mobile device usage for employees and guests. Given the ample 

Ethernet cabling available and the existing router in place, these WAPs may be configured as 

wireless bridges, extending the existing LAN into a wireless network. At least once WAP should 

be installed in the Computer Room, the Offices, and Warehouse, to ensure maximum wireless 

coverage. Each WAP should be directly connected to an Ethernet connection to extend the 

wireless network’s range without degrading signal quality. The WAP in the Computer Room 

may be connected to the main switch, while the Office WAP can connect to any unused Ethernet 

terminal, and the Warehouse WAP will be connected to the existing Warehouse switch. Each 

WAP should support 802.11AC and dual-band 2.4 and 5 GHz technology, which supports the 

full range of a/b/g/n, and 2.4 and 5 GHz devices as well. Any a/c devices connecting to the 

wireless network will take advantage of increased Wi-Fi signal distance and speed, additionally. 

 Providing wireless internet access throughout the buildings will enable both employees 

and guests to utilize mobile devices like smartphones, tablets, and notebook computers on the 

network and internet, and may increase productivity. Wireless connectivity can inherently be 

affected by other signals in the area, and so wireless speeds may vary. Additional WAPs may be 

added where Ethernet connections are available if slow speeds are noticed. This connectivity 

may be achieved by purchasing high-end consumer-grade WAPs (like Apple’s Airport Extreme) 

or through an enterprise wireless offering, which usually involves a wireless survey to ensure 

proper placement of the enterprise-level wireless equipment. A diagram is available below. 



 

 

Web Technologies Consult 

 Building a website for Swagger Distribution is a highly recommended next step for 

taking the business to the next level. Building websites has become much easier over the years, 

and this can now be done with little to no experience. The first step is to select a domain name 

(web address), like google.com for example, for the company so that potential customers can 

find it easily online. A good rule to remember is that a short domain name that is easy to 

remember and ends in .com is usually best. Unfortunately SwaggerDistribution.com is no longer 

available, but a good alternative may be SwaggerDistribution.us. The .US extension signifies that 

Swagger Distribution is a US-based company, and is widely used and memorable. After 



selecting your domain name, you need to find a registrar that will process and manage the 

registration for you. Many companies, like GoDaddy and NameCheap, offer domain registrations 

and provide powerful tools for managing them. It is best to avoid registering your domain name 

with the same company used for web hosting, as any issues or disputes that arise with your web 

hosting company may impact your ability to access your domain registration. Your domain name 

registrar is like the title company for a new car purchase, where your car is the domain name 

itself. By separating the web hosting company and domain name registrar, you can park your car 

in any garage (web hosting company) that you choose. If you finance your car and garage with 

the same company, a late payment on your garage may impact the ability to move your car to 

another garage. 

 Once your domain name is registered, it is time to find a web hosting company to host 

your actual website. This can be done in-house using the servers available on-site, but to reduce 

costs and labor it is recommended to select a web hosting company instead. This will free up 

your technology resources to focus more on your actual business, instead of managing web and 

email servers as well. There are two options that would suit Swagger Distribution best. The first, 

recommended, solution is to use a Content Management System (CMS) like WordPress to design 

and manage your website. CMS offer powerful editing tools and themes that do not require any 

knowledge of coding in HTML and JavaScript (HTML5), and can also automatically handle the 

creation of a mobile website for visitors on smartphones. A theme will allow you to easily create 

a website that displays information regarding your business, displays images of sample products, 

provides a list of retailers you partner with, a map with contact information, and more. There are 

even themes and addons that may be used to include features like shopping carts and 

personal/corporate accounts so that customers may manage their relationship with Swagger 



Distribution online. Themes allow you to modify the look of the website automatically, without 

having to worry about the code or needing to understand HTML tags to ensure proper 

formatting. It is recommended that an online form, used to submit information from visitors to 

you, be utilized so that potential customers may provide you with contact information and 

questions regarding a quote or information on services provided. This interactive tool will allow 

customers to begin the acquisition process, further reducing the need to reach out to potential 

leads directly. A mobile version of the website will also ensure that potential customers can 

obtain more information about Swagger Distribution easily and at any time. 

 Finally, the second option for hosting your website is to go with a full-service provider 

like Squarespace. Squarespace takes the hassle out of web hosting, so that you do not have to 

manage uploading and modifying files on the web server or keeping any software up-to-date. 

Squarespace websites come with a number of themes already installed and available, providing 

quick and easy access to shopping carts, accounts, contact forms, maps, and more. While this 

may be a good option, you do lose some functionality like managing email accounts on your 

domain. This can be offloaded to a company like Google by simply modifying Mail Exchanger 

(MX) records in the Domain Name System (DNS), but at an added cost. 

 An example of a website incorporating the contact form and mobile website that are 

necessary and described above, are included below: 

 



 

Mobile website with proper formatting for all screen sizes: 

 

Contact form so that customers 
can reach you easily. 



 

Importance of Information Security 

 Information Security is an important aspect of any company’s Information Technology 

implementation and must be taken seriously. Proper Information Security practices help to 

ensure the security of Swagger Distribution, its employees personal information, and the privacy 

of the customers. By employing standard Information Technology and Security practices, we 

will be well prepared to protect the security of the company and the privacy of any personal 

information that is stored in databases and servers that Swagger Distribution operates. By failing 

to implement either of these two key practices, Swagger Distribution opens itself up to 

penetration that may result in: destruction or loss of data, leaked personal information of 

employees like Social Security Numbers, and the compromise of sensitive customer information 

including credit card numbers, and sensitive corporate operations. Failing in any of these ways 

will open the company to litigation and loss of a hard-earned and respected corporate image in 

the industry. 

Recommendations 

 A good foundation of basic security principles is required for any effective IT solution, 

and so these recommendations will focus on ensuring the basics are implemented. A more 

comprehensive security solution is recommended after implementation of this needed baseline to 

ensure any further efforts are effective. 

 First, Swagger Distribution will implement a comprehensive password policy that 

impacts every employee. In order to ensure that employee passwords are secure and not easily 

guessable or exploited through Brute Force attacks, this new policy will require that passwords 

meet the following criteria: 



1. No less than eight characters long. 

2. Must include at least one capital letter. 

3. Must include at least one numeric digit. 

4. Must include at least one special character (like !, @, #, $, etc.) 

In addition to the new password policy, mandatory password resets will be implemented 

automatically by the access control server every sixty (60) days, and re-using the same password 

within the last twelve (12) month period will be disallowed. Research has shown that passwords 

that do not adhere to these standards are much more easily guessed, exploited through Brute 

Force login attempts, and are easily matched with existing words in a dictionary (Microsoft n.d.). 

Enforcing the above policies will ensure that passwords can not be easily guessed and that Brute 

Force attempts will be largely impractical due to the incredibly high number of possibilities per 

password that follows these policies. Additionally, forcing employees to change their passwords 

regularly will help mitigate any unauthorized access if a password were to be compromised. 

 Next, private customer information stored in our databases will be fully encrypted using a 

salted hash that requires this salt (key) for decryption. The key will be kept separate from the 

encrypted data at all times, and not be available outside the internal network. Storing of credit 

card and other payment information will also be outsourced to a PCI-compliant third party, to 

remove the possibility of any compromise on Swagger Distribution’s end affecting that of our 

customers. This also has the benefit of removing liability from the company, and ensures that 

sensitive data is entrusted to a third party practicing the data protection standards in the industry. 

This will also bring the added benefit of more secure and automated payments for customers that 

purchase frequently and may desire automated billing. By encrypting other information obtained 

from Swagger Distribution’s customers, we will be operating at a higher than normal industry 



standard for protecting the personal information of our customers. Though the unintentional leak 

of the non-secure information we store may not be wholly damaging to a customer, ensuring that 

we protect the information we store removes the possibility of that being used to attack our 

payment processor or any other company using private information obtained from Swagger 

Distribution. As was seen with the recent Sony Pictures hack, obtaining any amount of personal 

information through a security compromise may be deeply embarrassing and damaging to both 

parties involved (Peterson 2014). 

Conclusion 

By implementing both of these basic security practices, Swagger Distribution will be well 

positioned to protect the personal and private information of its employees and customers. This 

will also lay the groundwork for a more comprehensive security solution that works to secure 

each server and workstation directly, preventing malicious software from mitigating the 

implemented security practices described above. Additionally, and compromise that may occur 

either on Swagger Distribution’s end or that of the new payment processor should be limited in 

scope. Access to customer records will not reveal any plain-text information identifying them, as 

the encryption must be broken for any readable data. By migrating payment processing to a more 

secure third party, we also ensure that neither employees nor attackers have access to the most 

sensitive customer information that, when misused, may cause the most damage to the business 

and its customers. 
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